
www.adapx.com    info@adapx.com    877.232.7903     Rev 06-13

BEST PRACTICES for Microsoft® Excel® 

Designing Forms for Use with Capturx Mobile Forms
Capturx is an easy and flexible mobile form solution that enables teams to instantly integrate and share data collected  
in the field. As an add-in to Microsoft® Excel®, Capturx allows you to design a form once and make it available to mobile 
workers who use digital pens, tablets, or PCs for data collection.

When designing a form, it’s important to optimize for both the data collectors and for the data analysts. These best practices  
will quickly get you started building form templates for use with Capturx for Excel, Capturx® for SharePoint®, and Capturx® 
Forms Service.

NOTE: Capturx Forms for Excel does not support data collection on tablets. Tablet form design tips are for use with Capturx  
for SharePoint or Capturx Forms Service. 

There are four phases to designing a form with Capturx: “Plan”, “Layout”, “Format”, and “Test”.

Plan Your Form
To make your form more effective, we recommend planning your form before starting layout and formatting tasks.

•	Gather Requirements: When available, use current forms as a starting point. What types of data will be entered?  
Do the fields offer enough room for writing or touchscreens? Need a unique form identifier populated in each printout or 
tablet form?

•	Customize the Quick Access Toolbar: For quicker form design, take advantage of Excel’s Quick Access toolbar to select  
the Excel features you use most often.

–	Place the toolbar beneath the Excel ribbon, and customize it with links to design features such as Outside Borders  
and Merge & Center.

 • Organize Template and Worksheets: An organized workbook is simpler to use over time.

–	Rename the first worksheet “Master” or “Template” and the second worksheet “Wordlists” for your defined terms.

–	To avoid a cluttered workbook, delete sheets you won’t use.

NOTE: If working from an existing Excel form, be sure to stop sharing from the Review ribbon –  
Capturx does not print from shared workbooks.

•	Size/Performance Design Limits: It’s important to plan a form that will perform well in Excel. Capturx has built-in rules to 
prevent the design of a form that conflicts with Excel or Capturx limits.

–	Form design maximums:

▫ 4,000 Excel rows or 4,000 Excel columns in print area 

▫ 200,000 fields selected for Capturx formatting

▫ 60,000 items in a Capturx wordlist

▫ 990 checkboxes per form template

–	Form publishing maximums:

▫ Capturx for SharePoint/Capturx Forms Service 1.6.1: 2,000 Capturx-enabled fields per published form template

▫ Capturx for SharePoint/Capturx Forms Service 2.x: 5,000 Capturx-enabled fields per published form template  
(iPad best practice −no more than 1,000 fields per template)

▫ 50 pages per published form template
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•	Create a Design Grid: Base your template on a grid to make forms easier to create and update. To do so, adjust rows  
and columns into a grid of small cells.

–	Click the Select All button –  – or press CTRL + A, and then drag the boundary on the column heading to resize.

–	Later, you will merge the grid-like cells to create the optimal field sizes for your data collectors.

•	Adjust Margins, Headers, and Footers: Maximize design space on your template by reducing your worksheet’s  
margins, headers, and footers on the Page Layout ribbon, and define your page size and print area.

–	Select the ‘Page Layout’ tab, click the ‘Margins’ button and choose ‘Custom Margins’.

–	The .35” left margin is recommended because Capturx prints metadata, including the unique page address,  
on the bottom left of each printed page.

• Plan for Capturx Formatting: Capturx provides specialized formats to improve handwriting conversion for digital pen 
users and to provide easier data collection for tablet users. If the forms will be uploaded by digital pen users, the accuracy 
of handwriting conversion is greatly improved when you use specialized formats. As a best practice, we recommend that 
digital pen form templates include the general “Text” Capturx format as little as possible.

When you review your current forms, evaluate the data you want to collect and ask yourself, “Can any of the form fields  
be changed so the data is collected through checkboxes, wordlists, or custom expression fields?”
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Use this table to help plan how to structure your form’s data according to your requirements and Capturx formatting.

• Select a Wordlist Type: Before creating Capturx wordlists, you need to decide what type of wordlist is best suited to  
your data collection processes. A Capturx wordlist is a closed list of terms that are used to populate onscreen dropdowns 
and to limit digital pen handwriting-to-text conversion results. There are two ways to define a Capturx wordlist: enter  
a list of terms within Excel or use a pointer to refer to an existing SharePoint list. 

–	If all of your digital pen data is downloaded into Capturx Forms for Excel on the desktop, you will enter a list  
of terms into Excel to define a Capturx wordlist.

–	If your form data is uploaded to a Capturx server, your Capturx wordlists do not change often, and wordlists  
are not shared across multiple form templates, the simplest approach is to define the wordlist while designing  
the form template in Excel. 

–	If your form data is uploaded to a Capturx server, you may want to define the Capturx wordlist with a SharePoint  
list if the wordlist is shared across multiple forms, the list of terms will change often, the list of terms already exists 
in SharePoint, or the list of terms is imported from another line of business (LOB) system.

•	Defining Wordlists in Excel: Before you begin your layout, create your wordlists. This saves you time up front,  
so you can quickly assign wordlists when you assign Capturx formats to your fields.

–	On your “Wordlists” worksheet, copy your industry terms into Excel columns, one list per column.

–	Reserve the first row for heading titles for yours lists.

–	For easy recognition, create a border for the list, with extra cells so you can later add to the list.
–	Select the list without its heading and right click on it.

–	Name the list after the heading title and type the field name directly in the Name Box of the Excel formula  
bar (use underscores instead of spaces). Alternatively, you can right click on the field and select Define Name  
and give the field a name.

You can confirm the wordlist in Excel’s Name Manager.
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Capturx Format	 Input Device	 Type of Data Collected	 Examples
Checkboxes	 Digital Pen, Tablet, PC	 Choose one or more	 Yes or No options; list
		  from fixed options.	 of items to be inspected.

Wordlists	 Digital Pen, Tablet, PC	 One term out of a list	 Employee names, part
		  of known terms.	 numbers, product names, 
			   state abbreviations,
			   industry-specific terms.

Custom Expressions	 Digital Pen	 A fixed pattern of alpha	 Social Security Number, 
		  and numeric characters.	 Employee ID, Driver’s License ID.
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NOTE: Later, if you need to update the wordlist, do not change its range name. The handwriting on incoming forms  
will be converted to text based on the newest version of the wordlist, even if the form was printed before the update.

• Defining Wordlists in SharePoint: For a complete set of instructions (beginner and advanced),  
see the Capturx for SharePoint/Capturx Forms Service User Guide. 

–	In Capturx for Excel, create a Wordlist and assign it a named range. Give your named range a name  
that associates it with the SharePoint list. 

–	In Capturx for Excel, go to the Capturx Wordlist field you created. Instead of adding terms to the named range,  
paste the URL for the SharePoint list into the first cell of the named range on your Wordlist worksheet. 

•	Measure Current Forms with Layout Sheets: Many government and industry forms have exact design specifications.  
To save time duplicating a form, use grid layout sheets as rulers to measure elements on paper forms.

–	Create layout sheets in a separate workbook, with a worksheet for each different layout sheet you’ll print  
and use as a ruler.

Page 4

http://www.adapx.com
mailto:info%40adapx.com?subject=
http://www.adapx.com/support/capturx-sharepoint-server#tab2


www.adapx.com    info@adapx.com    877.232.7903     Rev 06-13

BEST PRACTICES for Microsoft® Excel® 

–	Label the worksheets according to grid size (25x25, 20x30, 40x40, etc.), and measure your existing paper forms  
to the largest possible grid.

By comparing a form to a grid layout sheet, you can determine the size and location of each form element, in grid units.  
Use a pencil to outline form elements on the closest grid lines on the ruler.

Layout Your Form
Forms should be easy – for teams to use and for Capturx to convert handwriting to text. Right-sized fields, appropriate labels, 
and visual elements help people better fill in a form. For Capturx to achieve the most accurate handwriting-to-text conversion 
possible, layout is key to success.

NOTE: As you build your form, save your workbook often.

•	Design Fields for Handwriting: Form fields are often too small for the information you expect someone to collect.  
To design for Capturx, follow these best practices:

–	Using the Excel Merge & Center feature within the Alignment ribbon, merge enough cells so tablet users can select 
fields with their fingers and digital pen users have room to write clearly and within the fields. Illegible writing will have 
more errors during text conversion. Handwriting outside a Capturx-formatted field will not be converted to text.

–	Avoid designs that result in fields that span across pages.

–	Finish the layout of your form before you label items or apply Excel and Capturx formats. You will design  
the form more quickly if you group visual layout, labeling, and formatting tasks.

•	Use Labels as Visual Cues: To help users write in fields, right justify horizontal labels, 
and shade and border fields.

If a label is in a writing area, insert a textbox – with 0 (zero) margins and without  
an outline – instead of taking up writing space. This style will not be visible on a tablet 
for date fields.

NOTE: For consistency, you can copy label textboxes to other areas on the form,  
or to other worksheets and workbooks.

Textboxes can be used to show how you want the information to be written (hint text).

For example, for a date in mm/dd/yyyy format, shade the font to a light blue –  
when you print on your color printer, the text will be shaded yet visible.

•	Highlight with Color: If several authors complete a form, use color to differentiate 
which part of the form relates to which role. For example, a technician would fill fields 
with a red border, while a supervisor would fill fields with a black border. You can also use color to fill cells where you don’t 
want people to write or type, such as column headings.

Page 5

http://www.adapx.com
mailto:info%40adapx.com?subject=


www.adapx.com    info@adapx.com    877.232.7903     Rev 06-13

BEST PRACTICES for Microsoft® Excel® 

Format Your Form
Capturx formatting is different from standard Excel formatting. Excel formats determine how the converted text looks  
in Excel, while Capturx formats apply rules to how handwriting converts to digital text and determine which input tools  
(date wheel, drop-down list, etc.) are displayed to tablet users.
•	Enable Capturx Formatting: To begin formatting with Capturx, enable your form by 

selecting Enable Form  
on the Capturx ribbon. For Capturx Forms for Excel, you have two options: Template and 
Direct. Once you enable  
your form, the Capturx ribbon is activated.

Template – Select Template if you are going to publish the form for use with  
Capturx for SharePoint or Capturx Forms Service. If you are going to use the  
form with Capturx for Excel, select Template to print blank forms − each  
imported form will create a new worksheet. This option fits most workflows.

Direct – For Capturx for Excel, select Direct when you want all pre-populated  
and collected data to be imported into the individual worksheet that was printed.	  

With Capturx for Excel, direct-enabled forms are best used when you want  
to pre-populate information in forms that will be used to collect additional data in the field. Direct-enabled forms let  
you use pre-populated information repeatedly, and can be iterated over multiple direct form worksheets in the workbook.

For example, you can print a form worksheet with pre-populated details for project #1234, and print another form 
worksheet with the same pre-populated details for project #1235, and then have each form individually completed.  
When the digital ink is imported from the two project forms, “direct” ink will come back to the appropriate project 
worksheet.

You can also reprint existing imported direct-enabled forms for additional handwriting – to capture an approval  
signature, to add more field data, or to allow data collectors in different locations to fill 
out different sections  
of the same Excel worksheet form.

•	Using Capturx Formats: Capturx optimizes handwriting conversion by emphasizing types 
of content used in your form. The more specific and restrictive the format, the better result 
you can expect from handwriting recognition. Fewer format types are needed for tablet 
form templates since users can review the data as they enter it. 

Assign Capturx formats from shortcuts on the Capturx ribbon, or from the format 
dropdown menu. Most formats are self-explanatory – Date, Full Name, Phone, etc.

Specialized formats are described below.

–	Text: Recognizes any text – use this format as little as possible for digital pen users. 
It gives the least guidance to Capturx about what data to expect. For tablet and PC 
users, this format will show the standard keyboard for typing.

–	Text + Terms: Any text plus specific terms from a wordlist.

NOTE: Text + Terms is not supported by Capturx Forms Service or  
Capturx for SharePoint.

–	Wordlist: Terms defined in a specified list only. This creates a drop-down list  
for PC and tablet users.

–	Alphanumeric: Converts letters and numbers – not symbols. This format  
is not needed for tablet users.

–	Handwritten Ink: For signatures, initials, freehand notes, and sketches –  
digital pen or tablets. Does not load to summary sheet columns in Capturx for Excel, 
or to columns in Capturx Forms Service or Capturx for SharePoint.
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NOTE: To make it easy for tablet users to markup images, format the image  
to be a light color so the touchscreen writing (black) will be visible.

–	Custom Expression: For digital pen data, define precise rules for entries that use letters and numbers. For example, 
here’s the custom expression that describes U.S. Social Security Numbers:

[0-9][0-9][0-9][-. ]?[0-9][0-9][-. ]?[0-9][0-9][0-9][0-9]
NOTE: If entries will use a combination of lowercase and capital letters, use [a-zA-Z] to define the range of letters.

–	None: Empty cells default to “None,” − Capturx won’t convert digital pen ink or treat them as Capturx fields.

• Autonumbering: To use the Capturx Forms Service/Capturx for SharePoint feature that automatically adds a unique ID on 
each paper or tablet form, first create a Read-Only field on each form page that will display the autonumber. Configuring 
the Read-Only field(s) to display an autonumber will happen later in the process using “list settings” on the server – not in 
Excel.”

• Formatting with Checkboxes: Checkboxes are a powerful tool for collecting form-based data.  
They are easy-to-use for data collectors, and enable accurate handwriting conversion.	  

By default, checkboxes are designed for a single small cell. After you assign a checkbox  
to a cell in your grid, you can resize the font of the checkbox to make it larger.

If your form has selections the digital pen user will circle, such as the words “YES” and “NO”,  
use a checkbox combined with a textbox.

–	Assign the Capturx checkbox format to the worksheet cell.

–	Create a textbox with the letter or word, and place it on top of the checkbox.

–	When a data collector circles the selection on a form, the checkbox will be selected.	  

You can combine checkboxes with shapes and images to populate data in your workbook.  
In this fuel gauge shape, checkboxes are used to track a fleet vehicle’s fuel usage.

If you use an image – such as a vehicle outline, human figure, or equipment diagram –  
make it transparent so underlying checkbox borders print.	  

•	Creating Named Ranges: When designing your template, use named ranges  
to identify form fields. They make writing formulas easier, and also help you to manage 
data in Excel summary sheets or SharePoint columns. To avoid having columns in Excel or 
SharePoint named after cell locations (A4, B5, etc.), assign  
names for all the form fields where people will write or enter data.
NOTE: If you are building forms for Capturx for SharePoint or Capturx Forms Service, create 
named ranges that are distinct from existing and default SharePoint column names (Title, Status, Created, etc.).

–	Select the field you’re going to name and right click on it.

–	Type the field name directly in the Name Box of the Excel formula bar (use underscores instead of spaces).  
Or, you can right click on the field and select Define Name and give the field a name. 

•	Name the Worksheets: If the data will be uploaded into Excel, Capturx can automatically assign a worksheet  
name that will make it easy for you to find a form related to a particular customer, sales representative, or any 
other data category.
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–	Select the appropriate field or fields, and then select Name Worksheet on the Capturx ribbon.

–	When a completed form uploads from a digital pen, a worksheet is named based  
on the fields you chose.	  

•	Using the Capturx Eraser: People make mistakes while handwriting. Place a Capturx eraser on your form so digital  
pen data collectors can re-set the field for new writing. If space allows, include a textbox with instructions for how  
to use the eraser.

–	Select Add Eraser on the Capturx ribbon.

–	The eraser appears over the last cell you selected. You can move the eraser just like any image.

– To correct mistakes, digital pen data collectors should cross out the original writing, touch the eraser with the pen  
tip, and then immediately write a new value in the same field as the mistake, unless it’s a checkbox. 

– For checkboxes, data collectors touch the eraser with the pen tip and then touch the incorrectly marked checkbox to 
retract the initial checkmark. Then make a checkmark in the correct checkbox.

Capturx keeps all handwriting, but only uses the newest text for conversion.

NOTE: If your form has multiple pages, each page should have its own eraser.

•	Adding Send to Phone: Capturx® Mobile for Blackberry® lets teams capture form-based data on digital pens  
and send it via a Blackberry to an email recipient, or upload it directly to a Capturx server. Add the Send to Phone tick  
box to the digital pen form template to save the effort of carrying a separate laminated card with the same function.

–	Select Add Send to Phone on the Capturx ribbon.

–	The Send to Phone tick box appears over the last cell you selected in your form, with a grey boundary  
to help you format.

–	You can move the tick box so long as the grey boundary doesn’t cross the border of the page, or overlap  
with another Capturx-formatted field.

•	Writing Formulas with IF Functions: For Capturx for Excel, how you write formulas can determine how your  
printed Capturx form appears.

In this example, typical fields of an invoice – quantity and unit cost – when empty result in a total of “0”.

Since the computation can’t be corrected on a printed form, write an IF function to create an empty Total field.
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 – Define names of fields (Quantity_1, Unit_Cost_1, Total_1) in a named range for easy reference.  
 Use underscores – not spaces – in names.

–	Write an IF function for the Total field: =IF(Quantity_1=0,” “,Quantity_1*Unit_Cost_1)

This means that if the Quantity_1 field equals 0 (e.g., if it’s blank), then a blank space should appear in Total_1,  
else multiply Quantity_1 by Unit_Cost_1 for the Total.

Note that the double quotation marks around the space are necessary for Excel to recognize that a blank space  
should be inserted.

Computation in Capturx for Excel – When you upload your Capturx form data to Excel, the formula results  
will display in the cell.

Computation in Capturx for SharePoint and Capturx Forms Service – Once the digital pen ink is imported into 
SharePoint, or tablet data is submitted, calculations are performed using either a calculated column or a SharePoint 
workflow. Without customization, the results of those calculations will appear in the SharePoint list view, not in the  
image of the form.

•	Form Life Cycles: For forms used with Capturx Forms Service/Capturx for SharePoint, you can translate the defined 
business process into a form lifecycle (i.e. uploaded, submitted, approved). Assigning a standard or custom form lifecycle 
is done in “list settings” on the server (not in Excel) with the assistance of your Adapx Solution Engineer.

Test Your Form – Capturx for Excel 
The last phase of form design is testing.

•	Highlight Your Form: Before printing your form, select Highlight on the Capturx ribbon.

Capturx formatting will display in Excel as areas lit in color, with the name of the format  
appearing as text (Full Name, Text, Number, Date, etc.).	  
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NOTE: Capturx formatting leverages the comment feature in Excel. If you use comments on your Excel spreadsheets,  
be careful not to edit any Capturx formatted fields.

Sometimes, extra cells may be accidentally assigned Capturx formats – the most common error is not merging  
cells and then assigning a Capturx format to them.

–	You may spot unneeded cells next to a Capturx-formatted field.

–	For cells that won’t be used to gather data, change the Capturx format to “None.” Redesign the field if necessary.

•	Print a Copy and Fill in Your Form: When you’re ready, test a printed form.

–	Select Print with Capturx on the Capturx ribbon and follow the instructions.

–	Fill in the form with your digital pen, and upload the digital ink into Excel  
to review.	  

•	Review the Pen Data: Reviewing ink as written helps you determine the overall 
effectiveness of your design, what to change, and the instructions users will need  
to fill in the form.

–	Select Ink on the Capturx ribbon to toggle between viewing converted text  
and the original ink written on the form.	  

•	Create a Summary: If you will be using Capturx for Excel for uploaded ink from 
a jobsite, it’s useful to test the workbook summary function.

–	From your template, select Summarize on the Capturx ribbon.

–	A dropdown lets you summarize all data or selected fields. Signatures, initials, and 
sketches won’t appear in the summary.	  

A summary sheet is added to the workbook, with column headings based on the form’s named ranges.

•	Finish the Form: Based on testing, make any design changes, and re-test the form. If changes are not necessary,  
start collecting field data.

Test Your Form – Capturx for SharePoint and Capturx Forms Service
•	Publish to SharePoint: The first step in testing your form is publishing it to SharePoint.

–	Copy the URL of your SharePoint site; you will need it to publish.

–	In Excel, select Publish on the Capturx ribbon, and follow the directions.

–	Based on your form template, a new list is created in SharePoint.
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While online and accessing your SharePoint site, do a quick 
verification that the form layout looks as expected.

–	Select the “New Form” button on the Capturx ribbon. 

–	Create a sample form.

–	Verify the template looks as expected.

•	Form Fields to SharePoint Columns: After you publish your form, decide which Capturx form fields should map  
to SharePoint columns. The two primary reasons for mapping are if a field will be used in List Views, or if a field will trigger 
an automated workflow. If a field meets either or both of these criteria, it should be mapped.

–	In SharePoint, select List Tools>Items>Manage Capturx Columns,  
and follow the directions.

–	When your form appears, click on a field to map 
 it to a SharePoint column.

–	When you finish, the field heading appears as a column heading for forms uploaded to SharePoint.	  

In this example, Survey_Date, ID_Number, Region, and Section columns are mapped from a Capturx form.

• For a Digital Pen Form, Print from SharePoint and Fill in Your Form: Print a copy of your form  
the Capturx ribbon.

–	Select List Tools>Items>Print Blank Form. Follow instructions  
from the browser.

–	Fill out the form with your digital pen, and upload the digital ink 
to the Capturx server.

NOTE: The URL for the destination Capturx server will need to be specified in Capturx Pen Manager.	  

•	For a Tablet Form, Create and Complete a New Form: Use a tablet to fill in all the fields. 

–	Select List Tools>Items>New Form. 

–	Fill out the form with a tablet and submit it to the Capturx server when you’re online. 

•	Review the List View: The uploaded form will create a new item in your SharePoint list. The item will display  
as a new row in the List View and the mapped data will display in the columns. Signatures, initials, and sketches  
won’t appear. You may need to refresh your browser to see the new row.

If you decide that additional columns are needed, you can update the Manage Capturx Columns mapping  
without changing your form template.

•	Review the Digital Pen Data: Viewing the ink as written will help you determine the overall effectiveness  
of your design, what needs to be changed, and what instructions users may need to fill in the form.

–	From the List View, select the Edit icon –  .

–	In the Form Layout View, you can check captured handwriting, images, ink metadata (timestamp and author), 
dropdown menus with wordlist terms, and text conversion based on Capturx formats.

–	In the bottom menu, select “Both” to see ink and text in the same view.

•	Finish the Form: If you decide to change the form layout or the Capturx formats, make the changes in Excel,  
re-publish your form, and re-test. If changes are not needed, you’re ready to use the form to collect field data.


